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Pressure Along a Streamline

Introduction

In this tutorial, Gambit® will be used to create and mesh the geometry for the problem.
Once this is complete, FLUENT will be used to solve for the flow field within the
domain and calculate the pressure distribution along a streamline from the domain
inlet to the stagnation point on the surface of the cylinder.

This 2D tutorial will provide more experience with 2D flows and also introduce you to
geometry creation FLUENT.

The methods expressed in these tutorials represent just one approach to modeling, defining and
solving 2D problems. Our goal is the education of students in the use of CAx tools for model-
ing, constraining and solving fluids application problems. Other techniques and methods will be
used and introduced in subsequent tutorials.

An incompressible, inviscid fluid
flows steadily past a cylinder.

The fluid velocity along the
streamline that ends at the stagna-
tion point is found to be:
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where 7 is the radius of the cylin-
der and Vo is the upstream veloci-
ty. Determine and plot the veloci-

ty and pressure gradients along
the streamline.
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Creating Geometry

Begin the problem by creating geometry in s oleli
Gambit. :

520 olfE

The Gambit standard display should be
open.

Meshes are generated in Gambit by follow-
ing left to right the menu icons located in
the top right of the display window.

First create a rectangle as the computation-
al domain.

Operation > Geometry > Face

Note: Icons with a red arrow have a pull down menu. To
activate the pull down menu select the icon with MB3.

Operation

W@IIIWI

Select the Create Face icon with MB3, and
make sure the rectangle option is selected

S
"m "l;l{l) Rectangle i é/
®T-> Circle =
An additional working window should €
appear named Create Real Rectangular S

Face.

Create Real Rectangular Face

Enter the dimensions for a rectangle of width lr
width =50, and height = 40. — IT ‘H

Select Apply. b
Coordinate 3ys. IT 3'

Note: To fit the geometry to the screen in Gambit, simply Direction v Cantered |

select the top left icon from the menu on the bottom right

of the display window. Label |

57 Appl Reset Close
‘*ﬁl (| | |
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Creating Geometry

Now create the cylinder in the center of the
rectangle by selecting the same Create Face

icon wtih MB3 and activating the Create Radus 1

Create Real Circular Face

Real Circle Face. Make a circle of radius =

1 select Apply and then Close. ty
Coordinate Sys. IW £I
Plane WY
Label |

| Applyy I Reset | Close

Since there is no flow inside of the cylinder, @ —
the circle face must be subtracted from the ~ vCi
rectangle face to create the desired domain.

Click on the Join Faces button with MB3
and select Subtract Real Faces.

Pick the rectangle with Shift + MB1 as the
first face and the circle (Shift + MB1) as the Fce [ o
face to be subtracted. Since only the newly “

created face is required for the solution, I G

leave the two Retain boxes unchecked and Subtract

select Apply. Fema |1race.z'e | of
If problems are encountered in creating the e

geometry, the geometry can be loaded from the Aty | Reset | Gose |

file “Stagnation_geometry.dbs”.
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Meshing Geometry

In order to create a mesh for this 2d
domain, the edges of the geometry must
tirst be meshed. In this case the only edge
mesh required is that of the cylinder.

Operation > Mesh > Edge > Mesh Edges @

— (&

Select the circle edge. In the Spacing sec-

tion change the pull down menu to Edges [ages 1
Interval Count and enter 30. Click Apply. M Pick with links  Reverse|

Soft link Er—— |

i Use first edge settings

Grading T spply Defaultl

Type Successive Ratio — |

Inver‘[l -1 Double sided

Ratio l]

I 1

Spacing W spply Defaultl

20 Interval count  — |

Options W tesh
1 Remove old mesh
- Ignore size functions

Agoly I Reset Close

Your domain should resemble the one
shown to the right.
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Meshing Geometry

Now create the interior mesh.

Operation > Mesh > Face > Mesh Faces i | —

Select the entire face by clicking on any one

of the edges with Shift+MB1. In the Faces IIrac:eJ ﬁl

Elements pull down menu change the ele- schemer I Ao

ment type to Tri and click Apply. creme )
Elements: Tri -

T¥pe:  pave |

Spacing: W apply Defaultl
|E1 Interval size |

Options: I Mesh
- Remaove old mesh
o s e mith
- Ignore size functions

Apply | Reset Close

The mesh should resemble the one shown
to the right.
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Boundary Conditions

The next task is to specify the bondary con-
ditions.

The first step is to specify the solver that
will be used.

Solver > Fluent 5/6

Next, bring up the Specify Boundary
Types window.

Operation > Zones > Specify Boundary
Types

From the pull down menu under Entity,
select Edges.

Select the top, left, and bottom edges of
the rectangle.

Type the label inlet next to Name.

Select Velocity Inlet from the Type pull
down menu

Select Apply. The boundary condition
should appear in the list at the top of the
Boundary Types window.

Now create the last two boundary condi-
tions in the same way. The far right edge
of the rectangle as an outflow and the
cylinder as a wall. The list should resem-
ble the image to the right.

Solver
+ Segregated
Coupled
Space

+ 2D
Axisymmetric
Axisymmetric §

Velarite Farmnlating

Specify Boundary Types

FLUENT 5/6

Action:
4 Add ~ Modify
« Celete ~ Delete all

Hame Type

inlet WELOCITY _IMLE
cylinder Wall

outflow OUTFLOW

<1 121 | &
- Show labels _i Show colors

Hame: I:

Type:

OUTFLOW — |

Entity:

e )T o

Label Type

;

Remove | Edit |

| Apply I Reset | §lose |
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Exporting the Mesh

Now export the mesh that will be imported Fie Edit Solver

into Fluent Hew ...

Open ...
Save

File > Export > Mesh
Print Graphics ...
Run Joumal ...
Clean Joumal ...
View File ...

Make sure the Export 2d (X-Y mesh) box is

»¢ Export Mesh File

selected.
File Type: UNS / RAMPANT 7 FLUENT 5/6
Select Browse... to choose the saving direc- File Name: | Cylindefsh | ==
tory for the mesh file. I Export 2-f-) Mesh
. Accept a
Save the mesh as Cylinder.msh. _pecept | | G |

Also save the Gambit file.

File > Save

Save the file as Cylinder

If problems are encountered in meshing the

geometry, the mesh can be loaded from the file
“Stagnation_mesh.msh”.
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Starting in Fluent

Open FLUENT from the Desktop or Start
menu.

Select 2D

Select Run

The following window should appear.

This is the FLUENT user interface. Most
tasks are completed using the menus across
the top. The menus are designed to guide
you through the analysis in an orderly
fashion, going from top to bottom through
each menu, and left to right across the
menu bar.

Now import the mesh into Fluent.
File > Read > Case

A browse window should appear.
Locate Cylinder.msh and select OK.

FLUENT will read in the geometry and
mesh you created. If there are problems
reading the mesh, return to the beginning
of the tutorial and make sure you follow
the steps carefully. If there are no problems
the command window should state
“done”.

Now check the grid for errors.
Grid > Check
Any errors will be listed, otherwise the

command window should again state
“done”.

VYersions

2ddp
3d
3ddp

Selection
|2d

Run | Exit ‘

& FLUENT [2d, sigregated, lam] i)
File @Grid Define ®Solve Adapt Surface Display Plot Report  Parallel Help

i = 3

Welcome to Fluent 6.1.22

Copyright 2863 Fluent Inc.
A1l Rights Reserved

Loading "C:\Fluent.Inc\fluentd.q1.22\1ib\f1_s117.dmp"
Done.

>

FAFLUENT [2d, segregated, lam]

File dGtid Define Solke Adapt  Surface

I NV
‘Wirite: 3

Case & Data..,
Irnport
Profile. ..
Hardcopy...
Batch Options. ..
Save Layouk Scheme. ..
Journal...
RSF...

Exit:
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Deftining the Problem

Default settings for the Fluent Solver will
be sufficient for this problem.

Define > Models > Solver

Confirm that the Solver options are the
same as shown on the left.

Now change the viscosity model to an
inviscid flow.

Define > Models > Viscous

Select Inviscid and then Ok

Since the cylinder is centered at (0,0) in the
domain, the reference pressure for the solu-
tion must be moved into the domain.
Define > Operating Conditions...

Move the reference pressure location to the
top wall by setting X to 0 m and Y to 20 m.
Now set the desired inlet velocity in the
Boundary Conditions menu.

Define > Boundary Conditions...

Select the inlet from the column on the left
and then click on Set...

Solver Formulation
= Segregated * Implicit
" Coupled o

Space Time
* 2D * Steady
O Axisymmetric " Unsteady

' Axisymmetric Swirl
~

Yelocity Formulation %
* Absolute
" Relative

Gradient Option Porous Formulation
@ Cell-Based * Superficial Yelocity
" Node-Based " Physical Velocity

0K | Cancel‘ Help|

Operating Conditions !|
Pressure Gravity
Operating Pressure [pascal] [ Gravity
[101325
Reference Pressure Location
¥ [m] ’ui
¥ [m] ’207

0Iﬁ\| Cancel| Help |
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Defining the Problem

Change Velocity Specification Method to
Magnitude and Direction and set Velocity
Magnitude to 1. Ensure that the X-
Component of Flow Direction is set to 1
and that the Y Component is 0. Click OK
and exit from the Boundary Conditions
window.

This case will be solved with a second
order discretization, so change the solution
controls for momentum to second order.
Solve > Controls > Solution

Change the drop down menu for

Momentum to Second Order Upwind and
click Ok.

The problem can now be initialized.

Solve > Initialize > Initialize...

Select inlet in the drop-down menu labeled
Compute From and verify that the Initial
Values match the inlet conditions:

Gague Pressure: 0

X-Velocity: 1

Y-Velocity: 0

Click on Init to initialize the computational
domain and then close the window.

=

[

Velocity Inlet

Zone Name
|in1et

4

Velocity Specification Method |Magnilude and Direction

Ll

Reference Frame |Ahsu|u|8

Velocity Magnitude [m/s) ‘1| |cunstant

1

X-Component of Flow Direction ‘1 |cunstant

Lellel

YY-Component of Flow Direction ‘u |cunstant

0K ‘ Canl:el‘ Help ‘

Solution Controls

Equations =] = Under-Relaxation Factors

Pressure 0.3 =
Density ‘ii

Body Forces ‘i_

Momentum ‘u_]
2

Discretization

Pressure I—Sm;j = ‘

Pressure-Velocity Coupling iSlMF‘LE |

LELEL Y Second Order Upwind - [

0K | Default| Cam:el‘ Help‘

Solution Initialization

Compute From Reference Frame

" Ahsolute

Initial Yalues

Gauge Pressure [pascal] 8

* Velocity [mfs] & I

Y V¥elocity [mfs] |8

=

_I|E§_| Fleset! Apply Close! Help|
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Solving the Problem

The problem is now almost ready to be

SOlved’ Residual Monitors
Options Storage Plotting
. . ~ Print It ti T Wind =
Solve > Monitors > Residual... o Sl R e
Mormalization lterations 1p00 =
. . Normalize ¥ Scal fxes... | C
Make sure Plot is checked in the upper left Prme T TENE || St | Supves
corner and uncheck all of the boxes in the Residual Marior Corve it
Check Convergence column. Fluent can Gty Nk 9.80;
. . . . x-uelocity v a.881
automatically stop iterating once residuals —
. . |y-velocity v \% 08.0801
have reached a certain value. For this case
the solution will be monitored manually.
Click OK.
Ok Plot Renorm Cancel Help

Now begin iterating on the solution.
Solve > Iterate...

Begin with 600 iterations. Convergence
will depend on the computing platform
being used. The residuals should taper off
after 400 iterations or so. The solution has
stopped changing when the residuals
become constant. A good indication of a
converged solution is that the residuals
have dropped at least 4 orders of magni-
tude.

Iterations
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Analyzing the Solution

The problem statement calls for a graph of
the pressure and velocity distributions
along a streamline from the edge of the
domain up to the stagnation point on the
cylinder. In order to plot distributions
along this streamline, a line must be creat-
ed in Fluent along the desired path.

Fluent can create lines in the domain based
on two user-specified points (the points
require both X and Y coordinates) in the
domain that are used to create the slope of
the line. Fluent automatically takes this
slope and draws a line across the entire
domain.

Surface > Line/Rake...

Create a horizontal line along the stagna-
tion streamline by entering the first point
(X0,Y0) at (0,0) and the second point
(X1,Y1) at (1,0). Name the line streamline
under New Surface Name. Click Create
and then Close.

Line/Rake Surface

Options Type

" Line Tool |Line j|

Heset

End Points

3

me — ximy
yimi — yime
e

—

Select Points With Mouse

MNew Surface Name

‘streamline

Close

Help |

Creatg Manage...

)
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Analyzing the Solution

Now that a line has been specified, plots of
the pressure and velocity can be created
and compared to the analytical solution.

Plot > XY Plot...

Change the two pull-down menus under
the Y Axis Function section to Pressure...
and Static Pressure respectively. X Axis
Function should be set to Direction Vector.
Select the streamline from the list of edges
to plot against and click Plot at the bottom
of the window. A window should appear
with the static pressure distribution along
the entire streamline. Since nothing down-
stream of the stagnation point is required,

change the X-Axis range to display only the

desired section.
Click on Axes... in the XY Plot window.

Unchecking Auto Range under Options
will highlight the Range section in the mid-
dle of the window. Change the Minimum
to -25 (the far edge of the domain) and then
click Apply and then Close.

Now replot the graph by selecting Plot one
more time. The new plot should look sim-
liar to the image shown.

Solution XY Plot X

Options Plot Direction Y Axis Function
v Mode ¥alues X[q |Pressure... -
W Position on X Axis : T %
Yg | Static Pressure -
I Write to File " X #xis Function
| Direction Yector -
File Data El= Surfaces ==
cylinder
default-interior
\inlet
outflow

Load File... k;

Free Data

Plot Axes... | Curves..  Close | Help |

Axes - Solution XY Plot

Axis Number Format Major Rules
o TVIJC
Y general -
Label Precision
3 =
Options Range Minor Rules
Log Minimum
Auto Range |-25
I Major Rules .
Minor Rules Maximum
a
bRéJIy | Close Help [

 TLUANT 19 et b

* sireamline
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Analyzing the Solution

Now plot the velocity distribution along
the same streamline by changing Y Axis
Function in the plot window to Velocity...
instead of Pressure...

Make sure that the streamline is still select-
ed in the Surfaces menu. The X-axis set-
tings will remain the same from the pres-
sure plot.

The velocity distribution should be similar
to the image to the left.

If problems are encountered in setting up or
analyzing this problem in Fluent, the solved
problem can be read in as Case & Data.... from
the file “Stagnation _cylinder.cas”.

Solution XY Plot
Options Plot Direction " Axis Function
v Node Values ®q Pressure... -
v Position on ¥ Axis = Pressure
Nar Sure...
Density...
I Write to File
Cell Info...
Grid...
File Data El= Adaption...
Residuals...
Derivatives...
[inlet
outflow
Load File...
Free Data
Plot Axes... Curves... Close Help

Velocity
Magnitude s
{m/s)
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Analytical Solution

Using Bernoulli’s equation with the velocity

profile given in the problem statement the
pressure distribution can be found to be:

2a2 1(aY
P =P +pV | —||1-=|—
X 2| X

Plotting the analytical velocity and pres-
sure distributions with corresponding
Fluent output reveals good agreement as
can be seen in the plots to the right.

o
w

Velocity Magnitude (m/s)
[=]
>

V)] I

o
=
T T

~

@ Fluent
Analytical

-25

0.5

Static Pressure (Pa)
< =]
w =N

o
S|

0.1

-20

-15 I—1C|I -5
X Position (m)

@ Fluent

Analytical

o 0 =2
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